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2.1 Deactivating - Activating licenses 

Activating or Deactivating Your Software   

Terminology:   

Game Builder:  This is the portion of BRAVO! that builds the game. You add your 
questions here, import images, set up your game settings, etc.  

http://www.c3softworks.com/manuals/bravo/help.html
http://www.c3softworks.com/


Game Player:  Once a game is made in the builder, it is now a stand alone game and 
no longer needs the builder to be played. It can be played on a local computer or over 
the internet (if using web version). If you need to make changes to any settings, 
questions, or avatars, you will need to open up the  Game Player  in the Game 
Builder  to make them.    

Licenses:  When you purchase BRAVO!  you will be given a license code for both 
builder and player. It may look like one license,  but it is really 2. When a license 
is issued, the license is applied to the builder and to a player. The builder license is 
activated when you first open up the Game Builder  for the first time or in demo mo de. 
The player license is activated when you first launch a game made with the builder. The 
first time you preview a game, you will note a pause  as the player license activates. 
This will only occur the first time you launch a game.  

General Instructions:  When you first open up BRAVO! after it is first installed, you 
will be prompted to enter your  license code.  At this point, you can simply copy and 
paste the license code you were issued in the License field.  You will note additional 
fields like, email address, first and last name, that should be filled out as well.   

Using Demo Mode:  Demo mode will allow you to make and play games to try out the 
software. When you create a game In demo mode,  half of the questions will be pre -
populated with questions and answers that can not be changed as long as you are in 
demo mode. Once the software is licensed, the pre-populated questionswill be 
removed. Demo mode allows you to use all of the features within the game builder  and 
publish a demo game.  

To Change Game from Demo Mode to fully active: Go to the Tools  Menu, click on 
Enter License  and a field will pop up where you can enter your information.  

 

License Installation  Issues:  If you  receive any error messages (i.e "you 
have exceeded your licenses," or "invalid license code", please contact us to verify 
information or for tech nical support. Contact Customer Support or Sales.  

mailto:sales@c3softworks.com?subject=Customer%20Support%20
mailto:sales@c3softworks.com?subject=sales%20


Deactivating Builder License:  If you have only one license of the so ftware, and you 
want to move the license to another computer, you will need to deactivate the current 
license on one computer before it can be installed on another. To  deactivate a license in 
the builder, go to Tools , and click on Deactivate License  . For your license to be 
successfully deactivated, you will need to have a internet connection.  If you need 
additional licenses, please contact Customer Support . You will also need to deactivate 
your player license as well.  To do this, simply open up a game you have made, click on 
the gear symbol in the upper right -hand corner of your game, and then click on 
"Deactivate License." 

 

Deactivating Player License: If you  want to play a game on a different computer, or 
move a player license to another computer,  you will need to deactivate your license. 
Simply open up a game you've made, and click on the gear symbol and select, 
Deactivate.  

Q: I have a game that I have played in demo mode, but when I go to enter a 
license there is no place to enter it.  

A:  In versions of the software  prior to  v1.20 (look under "Help>Ab out" to see 
what version you have). You will need to deactivate the player license (see 
above) and the close the program.  When you reopen the program, you will be 
prompted to enter your  license code. In newer versions of BRAVO! the system 
has changed and will give you an opportunity every time the player is opened to 
enter your license code.  

 

mailto:sales@c3softworks.com?subject=Customer%20Support%20


 

To Transfer your License to Another Computer:  

If you want to transfer your software to another computer, or temporally set up on 
another computer, you will need to deactivate your license, both in the builder and in 
the player (instructions above).   If you  do not do this, you may find that you may not 
have enough licenses.  

Q: With other software, I only have to do it once, why do I have to deactivate 
both the builder and player license?  

A:  BRAVO! is unique, in that it allows you to play a game on another computer 
without installing a  builder. Many organizations will designate someone to build  
games and output them to remote users in play -only format.   This allows the 
organization to control their presentation content and provide a u niform training 
tool for their field trainers.  In cases like this, the creator gets a builder license 
and a player license (in most cases they are identical), and the end user just gets 
a player license.  

  

2.2 Importing MQS & MBG Into BRAVO!  

Importing My Quiz Show & My Billionaire Game into 
BRAVO! 

General Instructions: If you have made games with My Quiz Show or My Billionaire 
Game, you can convert those games in BRAVO! to import them.  



Instructions: You will need to select which game style you are going to import. If you 
are importing a My Billionaire Game, click on Billionaire; for My Quiz Show, click on 
Quiz Show then go to File. Click on  Import Legacy Files , and create a new game 
name, when prompted. Now, look for a dat.mbg or dat.qiz file within the game folder of 
the game you want import to BRAVO!. You will only be able to see these file extensions 
through Import Legacy Formats.  This will bring in all of your questions and images 
into the game, including any settings you may have selected.    

 

NOTE: You can not import BRAVO's Quiz Show or Billionaire Game into a legacy 
game. Watch Video Tutorial On converting Legacy Formats to BRAVO!  

2.3 Checking For BRAVO! Updates 

Checking for BRAVO! Updates 

When an update is available, a notice will appear, in the upper right of the game 
builder, indicating that there is a new software update available, Click on Download 
Update to update your software. You can also click on Tools  to check for updates, as 
well.  

v1.20 or Higher:  This feature is only available with 1.20 or higher.  If you have 
an earlier version of BRAVO!, please update your software (Free to all users) to be 
notified of future updates and fixes in the software.  

http://www.c3softworks.com/videos/converting-leagacy-files-to-bravo/converting-leagacy-files-to-bravo.html


  
 

NOTE: Updating your software will not effect your avatars, libraries or previous games.  

2.4 Software Version 

To Check what Software Version you Have  

When calling in with technical support issues, you may be asked to confirm what 
version of the software you have. You can do this in 2 locations in the game builder:  

1. The lower right hand corner in the game builder (see image below).  

2. In the About section, under the Help menu. Under the About pop up, you will be 
able to see your registration code for your product, along with what version (i.e. 
Classroom. Web, or LMS).  



 

 



 
The About Menu is located under the Tools Menu. In the example above, you will 
see that the software is the BRAVO! LMS Suite, and the version number is 1.20. Just 
below this is the registration code.  

2.5 Using Slammers/Ring-in Devices 

Using Slammers/Ring-in Devices 

 
  

  

  

  

---------------------------------------------------------------------------------------------------------------------
--------------------------- 

The Slammers are a separate hardware component that communicates directly with the 
game software via a USB hub. The Slammers will tell you who rings in first, and will 
automatically apply scores to the team that rang in.  

 

 

 
Wireless Buzzer Video Tutorials 
 

These helpful tutorial videos will show you in 1 minute or less how easy it is to use wireless buzzers with 

BRAVO!  Also...see how you can easily set up your wireless game show slammer options, timers, and more!  

Watch the Tutorials    

http://c3softworks.com/resources/video-tutorials.html


To use your own ring-in devices, or to use the Slammers, you will want to disable the 
Enable take turns mode (Round Robin) mode in the settings area of the BRAVO! 
Game builder.  

 

Visual Indicators: When using the slammers that tie directly into the BRAVO! game 
player, you will see some visual indicators on the screen:  

Ring-In Indicator: Yellow Arrows pointing toward the teams/players indicate the 
slammers are un-locked and teams can ring in without being penalized.  



 

Question Timers: Under Settings in the BRAVO! game builder, (select a game style to 
view) you can set a question ring-in timer (How many seconds before allowing ring-
in?). Make sure you have timers enabled by checking next to Enable Timers (1 
). To set the amount of time that will lock out the slammers, go to the How many 
seconds before allowing ring-in? (2). You may need to experiment with this to 
develop a time that works for you.  Generally, 8-10 seconds is a recommended time 
frame.    



 

Read-in Timer in the Player: On the player side, this timer will lock out the slammers 
or prevent them (players/teams) from ringing in for a pre-determined time. This allows 
you time to read the questions. When a question first appears, you will note a timer 
above the question,in the upper left-hand corner (see image below). If you have a read-
in timer selected (A) in the game builder, this timer will appear first.  Next to the timer, to 
the right, is a lock icon (B) that offers a visual indicator that teams may not ring in. When 
you see a lock icon near the timer that indicates the slammers are locked out When 
unlocked (D ), you will see an un-locked icon. This, along with the moving yellow arrow, 
indicates that the slammers are unlocked and teams may ring in.  You can also disable 
the slammer ring-in timer at anytime by hitting the "L" key, or clicking on the timer 
directly, if you find you do not need as much time to read a question.  



 

To Test the Slammers When using the slammers that tie directly into the game, you 
can test the slammers, to make sure they are working, by clicking on the 
slammers.  Look for a lock icon, that will appear near the team/player on the screen that 
rang in. At anytime during game play, teams and players can see the lock icon, showing 
them that their slammers are indeed communicating with the game.  

    

Early ring-in penalty  If a team/player tries to ring in to early, when using slammers, 
they will be locked out for 3 seconds. This will be represented by a lock icon that will 
appear on their avatar or score area. 
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2.6 Playing your Game in the Classroom 

Playing Games in the Classroom  

Once a game is made, you have 2 ways you can launch it -- the first is through the 
game builder and the other is through a Play.exe file (PC). 



Launching a game from the BRAVO! Game Builder: 
Once you have made a game, you can launch it through the Game Builder. So, for 
example, if you have a game made in Quiz Show, click on the Preview button at the 
bottom of the large menu on the left side. If your game has not been named, the game 
will ask you to name your game and, by default, will attempt to save the game to your 
desktop, unless you choose another location. 

Launching a game from the Game Folder: 
When you make a game and save it, the game then resides in it's own unique folder, 
which is identified by the name you gave it. Once created, the games reside on your 
hard drive, separate from the BRAVO! game builder suite. They may be transferred 
and played on your computer, or any another computer with a valid BRAVO! Game 
Builder license.  

To Launch a Game from the Game Folder:  
Open up the game folder (identified by the name you gave it).  In the example below, 
there are 3 different games within a folder named My Games, lets say for example you 
want to Play the My Sample Game, you would then open this folder and then look for a 
file named Play or Play.exe (this may vary if you have your file ext. visible or not). The 
Play.exe will launch the game. On the Mac, you will just click on the Play file.  

 



 

Moving a game to another Computer: If you want to move your game to a different 
location on your computer or play it on another computer,  you need to move (or copy) 
the whole folder. The game needs many of the files contained within the folder to play 
your game. 

  

2.7 Placing your Game On the Web 

Placing Your Games On the Web   

To place a game online, you will need to have either BRAVO! Web or BRAVO! LMS,  
both of which create an HTML page you can link to. If you are not sure what version you 
have, click on the Help menu in the BRAVO! Game builder , and click on the About 
tab. This will show you the builder version you own. The image below illustrates what 
you would see if you owned the BRAVO! LMS builder version. 



About Menu 

 

Uploading to your Server via FTP   In the example below, we illustrate how you 
would place the game, "My Sample Game" online. Upload the folder 
My_Sample_Game and it's content to your server or website via file transfer protocol 
(FTP). Once uploaded, you will want to link to the play.html within the folder. 

 



 

When making games for the Web or a single Player   To make your game 
compatible for single player, you may want to enable/disable a few options. 

1. Under TEAMS, select 1 from the Number of teams drop down menu.  
2. Uncheck Prompt for number of teams. T his will lock down your player option 

to one player.  
3. Other options to consider: Allow character set up during game set up. This 

will allow the end user to change out their avatar/character. Note: If you enable 
advanced character editing, users can create their own avatar. By enabling 
Automatically launch character builder (web only and single player only), the 
avatar library will launch automatically.  

Issues with online play: 

Q: Why don't my images show up online, but play on my local machine? 
A: In many cases the issue comes down to a naming convention. For example, if you 
have an image you place in a game like, "sample summary.swf," some ftp locations will 
change the name of the file by adding an underscore where there are spaces. So, the 



file name online will read "sample_summary.swf." Because the name of the file has 
been changed, the file will not show up in the game online. If this happens, you will 
need to rename your files so it has no spaces.  

2.8 Audience Response Pads 

Audience Response Pads (Quiz Show and Spin Off)  

 
  

  

  

 
 
---------------------------------------------------------------------------------------------------------------------
--------------------------- 
 
Overview The Audience Response Pads (ARS) are compatible with the BRAVO! suite 
and currently work with the Quiz Show and Spin Off games. The software will currently 
work with a few different brands of audience response pads.  

Please Note: When playing in Audience Response mode, some features will be 
automatically disabled. Here is a list of the features that will not work:  

 Final question in Quiz Show, and wagering in both Quiz Show and Spin Off (final 
question). Spin Off will have a final question (last question of a game). Be aware 
that no final question will appear in Quiz Show.  

 The bonus points option (questions)  
 Enable take turns mode (settings)  
 "Try again"  
 Ring in timer (Settings )  
 Question timer will work, but when time is up, people can still place their 

answers. To stop polling, click on Next (this will reveal, by percentage, how the 
audience answered)   

 

 

 
Audience Response Pad Video Tutorials    
 
These video tutorials will show you the basics of using your Audience Response Pads with BRAVO!    
 

Watch the Tutorials  

 
  

http://c3softworks.com/resources/video-tutorials.html


Getting Started:  

1. Click on the Response Settings in either Quiz Show or Spin Off.  
2. When the Response Settings is open, look for Response type at the top of the 

Audience Response Settings page.  
3. Select the brand of Response Pads you will be using from drop-down menu. 
4. If you want to go back to normal play, then select the None/Slammers option.  

 

Audience Response Pads (ARS): BRAVO! will work with a few brands of Audience 
response pads.  Make sure that you select the brand you are using  from the Response 
Type menu. Currently, the software works with 4 different types of ARS pads -- the 
Reply Minis, Turning Point Response Cards, eInstruction CPS Pulse, and iClickers. For 
the most part, all of these pads can be used in the same way. There are several 
differences however.  

The Basics: There are a variety of keypads available, but all of them work essentially 
the same way. The front of the keypad provides the buttons the audience uses to select 
an answer for a poll/question. The back of the keypad contains a unique ID address that 
you can reference while in play or use as an identifier, if you pre-assign pads to a team 
or players. All keypads need a receiver (usually a usb device) that typically requires the 
installation of a driver to work.  

Turning Point Response Cards: In the Audience Response Settings, you can 
easily assign the pads by plugging in your USB receiver and entering your pads by 
clicking on any button on the pad.  

Using Pads as a Ring-in device: In this mode, you can only have one player 
(captain) per team. This allows you to use the pads to ring in when a question 
appears. This allows you to play a game in a more conventional format, where teams 



ring in to answer.  It will work similarly to the Slammers, but with some limitations. You 
are limited to one pad per team.IMPORTANT:  Multiple attempts to ring in will cause 
them to answer the question. The first time a keypad button is pressed, triggers a "ring 
in"  (if they are first of course), the second time a button is pressed, it will trigger an 
answer to the question.  

 

Anonymous Mode: With this checked, you will hide the end user's name on the game 
board (if you've assigned names to correspond with each of the pads -- see below). The 
names of players will still be accessable, while playing the game,  if you hover over the 
ID light near the team score box. Please note: This feature is designed for "no Avatar 
mode" (Enable Character is disabled in the Teams section) In lieu of the avatar, you will 



see only the IDs of each player.  If you hover over the ID light, with your mouse, you 
can't identify the player's name, but you can reference the ID number which is on the 
back of each pad.  

Prompt for Team Names: With this checked, you can change the names of the teams 
when the game is launched.  If you choose not to change the team names, you can go 
with the defaults or whatever names you have set up under the teams settings in the 
game builder.  

Prompt for Number of Teams: If you leave this option unchecked, you can lock down 
the number of teams on the player side. This option is only available if you have "Assign 
pads during game" checked. If you want the flexiblity to change the number of teams 
when a game is launched, you will want to enable this option, by checking the 
box.   When a game is launched, you will be prompted to choose the number of teams 
for your game.  

 

Total Number of Teams: You can pre-select the number of teams you want to use, 
when the game is launched, if you enable Prompt for number of teams.   This will 



allow you to adjust the number of teams on the player side. You can only adjust the 
number of teams on the player side if you have enabled the Assign pads during 
game.  

 

Turning off the Avatars and displaying IDs/Player Names: By un-checking Enable 
characters , in the Teams Settings,  you will turn off the avatars.  The Pad ID address 
or names of the players (if entered and not in Anonymous Mode) will appear in place 
of the avatars.   

Number of Players/Pads: You can play a game in BRAVO! with up to 250 
players/pads.  If you are playing with teams, you can have up to 50 players per team. If 
you were to use 250 pads, you would need to have at least 5 teams, or you would need 
to play in All Play mode.  

All Play Mode: To select all play mode, you will first need to select "no teams" (All Play 
Mode) in the drop down menu in the Audience Response Settings. In All Play mode, 
you have a few options that affect game play. There are no teams in All Play Mode . 
Results are displayed and reflect who answered the question correctly. The players are 
listed by highest score. In All Play mode , scores are based on correct answers and 
speed answered. Comprehensive results are saved by the software for future 
reference (located in Document>C3 SoftWorks> BRAVO! Response).  Results 
are categorized by the game style, date and time the game finished playing, i.e. 
 Spin_Off_results_5-29-2009_2.50PM would indicate a Spin Off game was completed 
on 5-29-2009 at 2:50 PM.).  



Anonymous Mode in the Audience Response Settings: With this feature enabled, 
the scores, ID and names of each player will be hidden. In this mode, the game will be 
less about competition and more about results.  The game software is still tracking 
individual results, in the background, which you can review after the game.  

 

All Play Mode Scoring: You have two options in All Play mode. Both modes will 
assign scores based on responses, but you can add a speed component to the score 
(the faster/slower you answer, affects the number of points that are 
awarded/subtracted) When you Enable the Timers (under game Settings, see image 
above) you will note that the points that appear in the question will start to decrease as 
the question timer counts down. Points are awarded based on the time it took to ring 
in and whether the answer is correct. If timer runs out, no points will be awarded, but the 
answer will be recorded in the game. If you would prefer to have the points remain 
static, then go to the game Settings, and uncheck the Enable Timers. To control how 
fast the point rates drop, simply increase or decrease the time in the question timer.  

When you turn off the timers: You will probably not have a clear cut winner. With the 
timers turned off in All Play Mode, the game will ascribe points based strictly on 
whether the participant got the answer right or wrong.  This leads to many ties.  



 

All Play Competition: If you want to play a game in a more of a competitive mode, 
where you are pitting one player against others, you can choose anywhere from 2-250 
players, and  assign names to the IDs.  This will display the IDs/name next to the 
scores. This adds a a level of accountability that amps up the competition. You can also 
play the game in Anonymous mode (by checking this in the game builder settings 
under Audience Response Settings ), where the names are hidden but the IDs will be 
displayed.  

Streamlining Game Set Up: If you know, for example, that you will only have two 
teams, and you know exactly what the names of the teams will be ahead of time, you 
can streamline the set up by un-checking the Prompt for Number of Teams (1 ) and 
Team Names (2 ) . This will eliminate two screens that appear when a game is 
launched. If you know for sure you will have 30 players in a session, you can also set 
that up on this page, by assigning pads to each team in the Audience Response 
Settings. This will allow you to launch the game and hand out the pads in the 
classroom with very little set up. The software is designed to give you flexibility on the 
player side, if you think you will need it.  Note: With 2-20 players, the game will display 
the name or ID along with the cumulative score.  When you have over 20 players on a 
team, you will not see the scores on the game board -- just the IDs or names.  



 

Assign Pads During Game: With this option checked (4) in the Audience Response 
Settings , you can assign the pads to teams in the classroom. When a game is 
launched, for example, you will see an area to assign pads for each team. To assign a 
pad to a team, click on each of the pads (any button) and the pad will be assigned to 
that team. You will note the pad address, in the left column.  If you want to assign a 
name to a pad, you type it in the right column next to the pad number. When you've 
completed this step, you are able to see (by keypad ID and name) who's on which team. 
This will make it easier for you to make sure you have the proper number of pads 
assigned to a team. You will repeat this for each team.  

Assign Pads In the Game Builder: If you happen to know who will be attending your 
training session, you can pre-assign pads (with or without names) to teams to save time 
in the classroom, you can easily assign pads and names to each pad (optional) by un-
checking the Assign Pads During Game box. To assign pads to teams, simply choose 
the number of pads you will be using, the number of teams you want, and the wizard will 
automatically distribute the pads to the teams. Keep in mind, that if you have 30 pads 
and you set up 3 teams, you will have 10 pads per team, if you have 4 teams, then you 
will have 8 pads on 2 teams and 7 pads on the remaining 2. The software will balance 
out the number of pads  as best as possible, but, depending on the number of pads vs. 
number of teams, it may not be equal. You can also assign a pad to a name here as 
well, by typing it in the right column. You can also do this in the Create Class Roster.   
This is the recommended way to assign pads to teams, especially if you will be using 
the same roster in multiple games. In this mode, you can easily change the team 
numbers and distribute the names with their IDs. On the player side, you can change 



the name or ID number, or even remove an ID/player. If you want to add IDs/players 
you will need to do this in the builder.  

Assigning Pads to a Team: To save time in the classroom you can assign the pads to 
teams ahead of time.  This is especially helpful if you are using a large number of pads. 
The first thing you will need to do, is enable the Assign pads during game.  Next, 
select the number teams under the Total team drop down menu.  You can have from 2-
10 teams (if you play with only one team,  then the game switches to All Play mode 
).  Choose the number of pads you will be using and click on Distribute Pads toTeams. 
You can change  the number of pads or teams at anytime, by clicking on Distribute 
Pads toTeams. In the Audience response setting , you will be able to increase the 
numbers of players to a team or change the ID number at anytime.  

Changing the Number of Teams: Changing the number of teams can be done at 
anytime. If, for example,  you set up a game and have assigned 30 pads to be 
distributed to 2 teams.  Later, you decide you want to change the number of teams to 3. 
No problem. To do this, select 3 teams, and then hit the Distribute Pads to Teams 
button.   This will redistribute the Pad IDs and names (if entered) to 3 teams.  

Create Class Roster: Click this if you wish to pre-assign specific pad IDs to individuals 
in advance of a training session.  This utility allows you to easily add your participant's 
names in one location, making it easy to view your class list as a whole. If you want to 
use this list in other games, or you want to set up multiple rosters, make sure you save 
the roster with a unique name.  

Adding TurningPoint ResponseCards : Compared to the Reply Minis     The address 
for the TurningPoing ResponseCards is a 6 digit address  You can simply type the 
address in manually. To do this, make sure that the Audience Response Settings and 
the Assign pads during game are unchecked. To start adding,  you simply click on 
any of the pads and it will assign the address in the game. Then, go to the Player Name 
(optional) and you can assign the pads to an individual.  

Add Pad: You can add an ID Pad to a team by simply selecting a team, then clicking on 
Add Pad . This will prompt you to " Enter Pad ID".   Enter the address of the pad ID 
here and that's it. Be aware: If you are adding an ID that is assigned to another team, 
you will want to make sure you remove it from the other team to ensure that the 
score is attributed to the correct player.  



 

Remove Pad: You can remove an ID Pad from a team by selecting a Pad ID and then 
clicking on the Remove Pad button.  

Save Class: When you assign IDs and names to teams, BRAVO! will automatically 
save the data within the game file. If you want to create an external file, for use with 
other games, or you want the ability to edit the data outside of the BRAVO! game 
builder, then click on Save Class , give it a unique name, and save it to your computer.  

Save Class As: If you want to create another variation of a class roster,  click on Save 
As , then give your roster a unique name. This will create a new data document, which 
you can easily edit outside of BRAVO!  

Load Class: If you have a course roster you have already made and it was saved as an 
external file, you can import that list into BRAVO! Response Settings for other game 
styles or new games made.  

Editing your Class Roster outside of BRAVO!: By saving your Class Roster as an 
external file, you can edit it with any basic spreadsheet program. This is a nice way to 
allow those, without a licensed version of the program, to add or modify names. In some 
cases, especially with large numbers of players, you may find it easier to work with a 
spreadsheet to make your class roster.  



 

Testing your Game: To test your game in Audience Response Mode, you will need 
the hardware and a receiver.  If you do not have the hardware, then you can preview 
your game by selecting None/Slammer mode in the drop down menu. We suggest that 
you make your game first and test it in None/Slammer mode, then set up your teams 
and audience response settings. You can still make changes to any part of the game 
while in Audience Response Mode.  

Player Side Instructions  

Initializing: When you first launch a game, the software will look for the ARS 
receiver.  You will see a loading icon while it waits. If you do not want your audience to 
see the initializing process, have the Intro Screen enabled under Settings in the game 
builder. This will give you a visual indicator that is more discreet. Another idea to 
consider, is to launch your game ahead of time so it initializes, and hit the Esc key, to 
minimize the screen until you are ready to start.  



 

Reports: Once you complete a game, a question, or when you quit, you will get the 
following prompt: "Would you like to view results data from this game?"  You can 
choose yes or no. If you choose yes, the results will show up in an html file in your 
browser.  If you choose no, the results will still be saved and you can find them in your 
Documents folder (under C3 SoftWorks) and the data will be in a folder named 
"BRAVO! Response."  The game will be named (Game name, Spin_Off or 
Quiz_Show)followed by the date and the time the game was completed. Example: 
Quiz_Show_results_5-30-2009_7.57PM.html  
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2.8.1 Audience Response Pads that work with BRAVO! 

Contact us to see if your pads will work with our software. This list is subject to 
change and may vary depending on model.  

Reply Mini Model CRS5000 

 

TurningPoint 



 ResponseCard RF LCD  

 ResponseCard RF  

 ResponseCard XR  

 ResponseCard IR 

 

iClickers 

 

eInstruction 

Classroom Performance System 

 Infrared  

 Radio Frequency  

 Pulse 

vClicker 

Interwrite Cricket 

 



  

2.8.2 Reply Minis 

 

  
   

Navigation: New Help > General Information > Audience Response Pads >  

 

TurningPoint Response Cards® (Quiz Show and Spin 
Off) 

 

Installation: For the Reply Mini®  to work with the BRAVO! Games (Spin Off & Quiz 
Show ), you will need to have the drivers installed, the cd will be with the pads that you 
received. 

Assigning Key Pads: You have 2 options to enter the Reply Minis® into a game. You 
can assign the pads in the game builder under Response Settings or assign pads 
during the game when first launched. 

Adding Reply Mini®:  Each reply mini® has a address located on the back of each 
card.  



To Assign a 
Card in the Game Builder:  To do this, make sure the Audience Response Settings 
is open and the Assign pads during game is unchecked (2), you can then enter the 
pads address under and it will assign the address in the Response Pad ID area (3). To 
add a new pad, click on Add Pad (5) Then go to the Player Name (optional)  (4) and 
you can assign the pads to an individual. When done entering your IDs and assigning 
them to names (optional), you can then save the entry into a class roster (6) that can be 
imported into other games. This class roster can also be edited outside of BRAVO! 
using any spreadsheet software.  

To Assign Pads in Game: 



 

Make sure the USB drive is in, it will take a few seconds to initialize (communicate with 
the USB receiver). You can then have players click on the pad to assign them to a team 
or the game (7). You can click on the area to the right of the response pad IDs, 
and assign names to the IDs if you choose (8). To remove a ID from the list, select it, 
and then click on Remove Selected ID (9) at the bottom of the columns.  

Color Code your Cards: To make assigning pads to teams easier, you may want to 
consider color coding your cards/pads, you can use colored lanyards or apply colored 
dots to the pads (both can be purchased at any office supply store). When a game is 
launched, you can then say all of those with red lanyards or a red dot on their card, 
please push any button now. 

Important: When using Turning Point with the BRAVO!, you need to make sure 
Turning Point in PowerPoint is closed. The Turning Point hardware can only 
communicate with one application at a time. If you plan on going from a PowerPoint 
presentation using Turning Point to a game using the key pads, you will need to shut 
down PowerPoint first. 
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2.8.3 Turning Point 



TurningPoint Response Cards® (Quiz Show and Spin 
Off) 

 

Pictured above: Turning Point Pad and USB Receiver 

Installation: For the TurningPoint Response Cards®  to work with the BRAVO! Games 
(Spin Off & Quiz Show ), you will need to have the TurningPoint Software installed, 
this contains the drivers for the receiver. Click Here to download the Turning Point 
Software if you have not already done so. 

 

http://www.turningtechnologies.com/responsesystemsupport/downloads/softwaredownloadsregistration.cfm?type=26&y=2008


Assigning Key Pads: You have 2 options to enter the TurningPoint Response Cards® 
into a game. You can assign the pads in the game builder under Response Settings or 
assign pads during the game when first launched. 

Adding TurningPoint ResponseCards®: Each TurningPoing ResponseCards® has a 
unique 6 digit address located on the back of each card.  

To Assign a Card in the Game Builder:  To do this, make sure the Audience 
Response Settings is open and the Assign pads during game is unchecked (2), you 
can simply click on any of the pads (USB receiver needs to be plugged in)  and it will 
assign the address in the Response Pad ID area (3). Then go to the Player Name 
(optional) and you can assign the pads to an individual. If you do not have the receiver 
plugged in, you can click Add Pad (40) and you will get see Enter Pad ID appear under 
the Response Pad ID, select it, and then enter the unique 6 digit ID.  When done 
entering your IDs and assigning them to names (optional), you can then save the entry 
into a class roster (6) that can be imported into other games. This class roster can also 
be edited outside of BRAVO! using any spreadsheet software.  

To Assign Pads in Game: 

 

Make sure the USB drive is in and no other TurningPoint Application is running. It will 
take a few seconds to initialize (communicate with the USB receiver). You can then 
have players click on the pad to assign them to a team or the game (7). You can click 
on the area to the right of the response pad IDs, and assign names to the IDs if you 
choose (8). To remove a ID from the list, select it, and then click on Remove Selected 
ID (9) at the bottom of the columns.  



Color Code Your Cards: To make assigning pads to teams easier, you may want to 
consider color coding your cards/pads, you can use colored lanyards or apply colored 
dots to the pads (both can be purchased at any office supply store). When a game is 
launched, you can then say all of those with red lanyards or a red dot on their card, 
please push any button now. 

Important: When using Turning Point with the BRAVO!, you need to make sure 
Turning Point in PowerPoint is closed. The Turning Point hardware can only 
communicate with one application at a time. If you plan on going from a PowerPoint 
presentation using Turning Point to a game using the key pads, you will need to shut 
down PowerPoint first. 

  

2.9 Using PowerPoint in BRAVO! 

Bringing PowerPoint slides into BRAVO!  

If you want to add additional teaching points, or want to use content from a PowerPoint 
presentation, you can save slides from PowerPoint as a JPEG, PNG, or GIF.    You can 
also get third party software that will allow you to export a single slide or multiple slides 
as an SWF.  

To save a PowerPoint slide for BRAVO!:  

1. Open up PowerPoint  
2. Go to the slide you want to export  
3. Go to File>Save As> from your main menu  
4. This will open up a Save As screen.  
5. Go to the bottom to Save as type (default is Presentation (*.ppt))  
6. Scroll down in the drop down menu and choose JPG, PNG, or GIF  
7. When you select a file you will be asked to choose either Every Slide or Current 

Slide. Choose Current Slide.  
8. Now you ready to bring the slide into BRAVO! 



 

 
Choose Current Slide Only when exporting. 

Making your Own Custom Intro Screen 



 

"Save As" the slide out as a JPEG image, Current Slide Only. 



 

Go to your game:  Quiz Show, Spin Off, or Billionaire Game -- Click on Graphics: 
Then click on the image button next to Load custom intro (603x417 SWF, JPG, GIF, 
PNG, FLV) to load your image. Now, your image will appear in the intro screen, when 
your game is first launched. Keep in mind, your PowerPoint is set to a different size, but 
this image will fit. You can always change the size of your PowerPoint layout to match 
the intro screens exact dimensions (603 x 417 pixels).  



 



 

In the default settings, you will see the Welcome to My Quiz Show (deleted in the 
image above) on the bottom.   You can turn this off by going to settings, and deleting 
the text or changing it. 

2.10 Question Library 

Library (available in version 1.25 and higher) 

 

 

 
Question Library Function   
 
BRAVO!  now has a Question Library that makes game creation a snap! Drag-n-drop questions from any 

category or game. Create, edit and import/export questions directly into the library. As a bonus feature, you can 

randomize your questions and categories for a whole new training game experience everytime! 

Watch the Tutorial    

http://www.c3softworks.com/manuals/videos/LibraryIntro/library_intro.flv


 
  

  

  

  

---------------------------------------------------------------------------------------------------------------------
--------------------------- 
 
To launch the library in any of the games, click on Questions, and then click on Launch 
Question Library, or go to Tools on the top menu and click on Launch Question 
Library. In this box, you will see a few options in your library.  

 



 

1. Library Name: This represents the name of the library. You can have as many 
libraries as you would like.  

2. Keyword Filter: This allows you to search a library or libraries for questions with 
a keyword or for a specific word in the question.  

3. Difficulty: This will allow you search for questions that have been assigned a 
difficulty level of 1,2, or 3.  

4. Library: You have multiple options with in this box: New, Open, Save, Save As, 
Import, Export, and Delete.  

5. Add (Folder):  Click on this to add a new category within a library.  
6. Add Question: Select a category and the button will become active.  This will 

allow you to add a question into a category.  
7. Remove: Select a category or question and you can remove it.  When removing 

a Category, it will remove all of the content within that category.  
8. Edit/Rename: If you select a category, you can rename it.  If you select a 

question, you can edit the question outside of the game board. By clicking on the 



edit button, you will open the question editor. In Showdown, you can only edit the 
questions in the actual question editor, found within Showdown.  

9. Category Names: The name of a category.  A category can contain as many 
questions as you would like.  

10. Questions: This represents the questions you have in each category. 

 

 
  

  

  

  

---------------------------------------------------------------------------------------------------------------------
--------------------------- 
 
To Edit a Question in the Library 
Select the question you want to edit, then select edit.   You will then be able to modify 
your question outside of the game board. This provides you with the flexibility to create 
questions first, and then decide where you want to place them on the board.  

Moving Question from one Category to Another 
You can move questions around from one category in the library to another by simply 
dragging and dropping. To move around questions on the game board, you will first 
need to drag it to the library, then drag it to back to the board. 

Quick Tip to Clear Question of All Content 
Click on the Add (no folder) icon, and add an empty question. You can then drag this to 
a question on the board and it will clear it. Keep in mind, once you do that, the question 
is gone, unless you placed it in the library. 

To move Questions from One Game to Another 
You can leave the library open from one game and open up another game format and 
drag your questions to the question area. 

 

 

 
Keyword Filter    
 
This allows you to search a library or libraries for questions with a keyword or for a specific word in the 

question. 

Watch the Tutorial    

http://www.c3softworks.com/manuals/videos/Library%20Search/library_search_help.flv


Drag and Drop Functionality 
To add a question from the game board to the library, you first need to select a category 
within the library, then simply drag and drop the question into the library. This will also 
bring in all of your content, including images, audio, summary and preview slides. To 
move a question from the library to the game, simply drag a question from the library to 
a question area on the game board. 

 
 
 
Making Your Questions in the Library 

1. Click on a category in your Library as the destination for a question. If you are 
starting with a new library, click on the DRAG QUESTIONS HERE, rename it to 
anything you want.  

2. With the Category selected, Click the question Add tab .  
3. Select the new Question Icon, and click on Edit, to enter your question, preview, 

summary, and other information. 

You can Import Questions using CSV Formats 
To import questions using a .CSV file format, click on Library tab in the Question 
Library, and then click on Import, to import your file.  

Exporting Your Library and Media 
To export your questions and any images or media files attached to the questions: 

1. Add your questions to a new library  

2. Save your library (Library>Save)  
3. Then Export (Library>Export) 



When done, this will create a folder that will contain your CSV file and all media 
attached to your questions. 
 
Need a template? Download the FREE CSV template here. 
 
Why use a CSV file? This allows others, who may not have the game builder, to enter or 
modify questions easily.  To export a question bank, click on Export in the Library drop 
down menu. To add images to the CSV file, make a new folder and give it a unique 
name. Then when entering your questions into the CSV file, you can add the media or 
image name in the CSV file, indicating when it should appear. Make sure you add any 
images and media to the folder.  

 
 
 
Randomizing your Questions and Categories 

 
  

  

  

 

 

 
You can easily pull questions from a library and populate a game randomly. Not only can you randomize your 

questions, but you can also randomize categories. As long as you have a library of questions and categories 

made, there is no need to enter any questions into the game builder, the game will pull content from the library. 

Watch the Tutorial    

http://www.c3softworks.com/manuals/files/questions_export.csv
http://www.c3softworks.com/manuals/videos/Randomizing/randomizing_questions.flv


  

---------------------------------------------------------------------------------------------------------------------
--------------------------- 
 
You also need to have enough questions in your library/categories to cover the number 
of question you have chosen on the game board. For example, if you choose Quiz 
Show and have chosen the game minimum (3 categories with 3 questions each), you 
need to have at least three questions in each category. If, for example, you have 2 
categories with 6 questions each, then the game will randomize the first 2 categories 
(since they are first), then will not have any content for the third category, so the game 
will default to what was placed on the game board, or be empty, if there are no 
questions entered. 

To randomize questions and categories, you do not have to enter any questions or 
name your categories in the game builder.  The game will pull randomly from the library 
of questions.  

1. Create your questions.  
2. Create a Category by clicking on the Add (Folder icon) in the library. Give the 

Category a unique name (this will appear as the Category name in the game). 
NOTE: You can have more categories in your library then you do on the game 
board.  However, if you have 4 categories selected for the game board, you will 
need at least 4 categories in the library.  

3. When you get your categories (with questions) set up in the library, you will need 
to name them, so they can be assigned to the game. Go to Library tab (4), select 
Save As, and give each category a unique name.  

4. Then go to Setting area of the main game board, and check Use randomized 
questions from library drop down box. Choose the library you want to use (look 
for the name in the drop down menu). If you do not see the library, make sure 
you saved it in the library.  

5. Launch your game, and you will now see it randomly pull questions from the 
library.  

6. Any time you make adjustments in your library, you will need to go into the library 
tab, and click on Save to update. 

If you choose to randomize, you do not need to enter any questions on the game board. 
If you do have questions, you do not need to remove them. The game will simply assign 
questions that are in the library.  



 

A note about Quiz Show and the Final Question 
If you choose to randomize and you have the final question enabled, you need to be 
aware that the game will treat the final question as a category and will randomize the 
content as well. A suggestion to get around this, is to create one less category in the 
library (do not include the category for the final question in the library). For example, 
let's say you have a 3x3 board selected and a final question.  In the library, create 3 
categories and place as many questions in the library as you want (just make sure you 
have at least 3 for each category). When the game launches,  it will randomize the first 
3 categories (it always starts with the first category listed), but since there is not a 4th 
category, the game will keep the final question as is (make sure you add one to the 
game board or turn off the final question). If you add 4 categories in the library, in this 
example, then the game will randomize the final question. Why is this a problem? It 
becomes a problem only if you are using summaries in a question. The final question 
can not display a final summary. 

A Note about Spin Off and the Category Colors and Icons 
When randomizing questions in Spin Off, the name of the category will become 



whatever the name of the category is in the library. You can not assign a color or icon to 
a specific category in a library. There are 2 ways around this: k eep your icons non-
specific  or keep them general, so they will match up with whatever the category name 
is.  If, for example, you want the categories in the library to be assigned to a specific 
category on the wheel, all you need to do is make sure that you name the category on 
the wheel and the category in library exactly the same.   

A Note about Billionaire Game Library 
Billionaire game uses a 4-answer multiple choice style question format and does not 
support open-ended questions. You can edit questions within the library so they will 
work in Billionaire. If you have a 5-answer multiple choice question, you will need to 
modify it to 4 possible answers. In random mode, the game will pull from a different 
category after each round. Make sure that each category has a enough questions to 
match what is selected on the game board. Category names will not show up in 
Billionaire, they are just placeholders for questions.  

A Note about Showdown Game Library 
The Showdown game is more of an open answer format with multiple correct answers. 
You can import multiple choice questions into the game, but they all will be correct. For 
the most part, you will use questions made in Showdown, only in Showdown, since this 
game plays differently than the other games.  
 
Showdown questions in the library will have the following icon  to mark the question 
as a Showdown question. (To save Show Down questions in the library, you will need to 
click and drag those questions from your Show Down game, into the library).  
 
To use Showdown in random mode, all your questions, in the library you choose to use, 
must have the red . 
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2.11 Question Editor 

Question Editor 
 
Each question you build in the Question Editor with BRAVO! is created, using a 
gameboard template. Each template offers a wide variety of options, to quickly and 
easily build a library of questions for any game.  

2.11.1 Quiz Show Editor 



Quiz Show Question Editor: 
 
NOTE: Copying & Pasting: To copy or paste in BRAVO!  use your shortcut 
commands. Ctrl + C to copy, and Ctrl + V to paste.  

 

Bonus Question: to make this question a bonus question, check the box upper right 
corner of Question Editor. 

(1) Preview: You can insert text, images, audio, or video here,to precede a question. 
This section will only appear when you've entered something here. This can be used as 
a teaching moment or as a?set up for the question.  



(2) Summary: You can enter text, images, video, here that will follow a question. This 
section will only appear when you've entered test or any media in the summary 
area.?This can be used as a teaching moment or as a review of a question.  

(3) Type: For open ended questions, you can choose from the Type drop down menu > 
Open-Ended or you can use the default answer style which is Multiple Choice. If you 
are choosing open ended, you will see on the game side a simple correct (check mark) 
or incorrect (red X) option to answer the question. Place the correct answer in the empty 
answer area in the game builder and the answer will show up after a question is 
answered.  

 Poll Option (Response Pads): When using Audience Response Pads or 
making a game online, you can have a question that has no wrong answer, this 
is a great way to poll the audience on any topic. It is only considered wrong if you 
do not answer the question. 

 

(4) Difficulty: This is optional, but you can rate your questions with a difficulty level of 1, 
2 or 3. This will prove helpful, if you need to sort your questions by difficulty level. This 
feature will work with our new library system coming out in October of 2009.  



(5) Font Attributes: When adding text to your question, you can modify the typeface 
(bold, italic, or underline).  To change the font style globally (whole game) go to 
Graphics  and choose a different Game Font. Remember, like PowerPoint, if you are 
making a game on one computer and plan on playing on another computer, make sure 
you use a font that will be on both computers.  You can also change the type layout here 
as well.  
 

Using Hyperlinks: Select the text you want to hyperlink, click on the link icon (A), in the 
pop up menu type in your address you want opened in the game in the URL. Leave the 
target empty. You may want to underline the text to it to give a hyperlink look (B). To 
open a file on your local drive, replace the http:// with the local address like: 
C:\pics\mypic.jpg, the only time you may want to do this is if you are using a file format 
that the game not exept.  

 

(6) Question Area: This is where you will type in your question.  

(7) Number of Answers: You can have up to 5 answers for your questions, if for 
example you have a True and False answer, then drop the number of answers to 2.  

(8) Answers: Type, or copy and paste your answers here. A suggestion is to try and 
keep your answers short. Use the Summary to add additional information or teaching 
points.    

(9) Load custom images/video (SWF, JPG, GIF, PNG, FLV): You can add images to 
the question, by clicking on the image button on the left. When the game is launched, 



you can click on the image to enlarge it (to full screen). Click again to make it smaller. 
When using images as part of question, the ideal size is 280x200.  

(10) Load custom audio (MP3): You can add audio files to the question, by clicking on 
the audio button on the left. You can only?import MP3 files for audio.  

(11) Topic Keywords (optional): You can give your question a keyword, that will help 
you search the database of questions if you choose. For example, if your question is 
related to ladder safety, you may want to use Safety as your keyword for a search. 
NOTE: A library will be added in October of 2009 and is not currently in the builder.  

Video Tips: When using video we suggest using a FLV (Flash Video Format) whenever 
you can. A FLV video when used will give you a playhead so you can pause or rewind 
the video. A SWF Video will just play and you will not have any control of it when using 
it. A SWF video will continue to loop until stopped.  

Online Audio Suggestion: If you want to narrate the text that appears on the screen 
you can insert that as a audio file that will automatically start when the question is 
previewed.  

Online Use of Images, Video and Audio files: Just like when posting things for a 
website, if you are using any content into your game you will want to make the files web 
friendly from a size perspective. It is suggested that if you are using images to try and 
keep the size no larger than 574 x 400 and to use web settings when saving the 
images, images used with in question would ideally be 280x200.  

2.11.2 Showdown Editor 

ShowDown Questions 

Number of Questions (1 ): This represents the number of questions you want in each 
category. In ShowDown, you can have anywhere from 1-20 questions. You can see the 
question text (2) here as well as the number of answers (3) in each question that 
appears to the right. To launch the library, click on Launch Question Library (4 ) on the 
bottom of the page.  



 



 

Copying and Pasting: To copy or paste, just right click, or use your shortcut 
commands. Ctrl + C to copy, and Ctrl + V to paste.  

Font Attributes (1 ): When adding text to your question, you can modify the typeface 
(bold, italic, or underline).  To change the font style globally (whole game), go to 
Graphics and choose a different Game Font. Remember, like PowerPoint, if you are 
making a game on one computer and plan on playing on another computer, make sure 
you use a font that is loaded on both computers.  



Using Hyperlinks: Select the text you want to hyperlink and click on the link icon 
(A). In the pop up menu, type in the URL address you want opened in the game. 
Leave the target empty. You may want to underline the text to give it a hyperlink 
lappearance (B). To open a file on your local drive, replace the http:// with 
the local address like: C:\pics\mypic.jpg.   

 

Difficulty (2 ): This is optional, but you can rate your questions with a difficulty level of 
1, 2 or 3. This will prove helpful, if you need to sort your questions by difficulty level. 
This feature works with our new library system.  

Question Area (3 ): This is where you will type in your question. You can do this as a 
poll, or ask a question with multiple correct answers.  

Number of Answers (4 ) : You can have up to 10 answers for your questions.  

Answers (5): This is where you will enter your answers. It is best to keep the answers 
as short as possible in this game. Use the Summary area for additional information.  

Assign Points for each Answer (6 ): You can assign a point value for each answer. 
You can give a higher point value for the most popular answer, or assign a higher point 
value on answers that are not so obvious. For example: Name 5 symptoms of a heart 
attack. The most obvious answer probably is Chest Pain, the least obvious is 
dizziness.  You could assign 100 points for Chest Pain, and 500 Points for Dizziness.  



Summary (7 ): You can enter text, or import images or video here, that will follow a 
question. This section will only appear when you've entered text or any media in the 
summary area. This can be used as a teaching moment or as a review of a question.  

Load custom images/video (8 )  (SWF, JPG, GIF, PNG, FLV) : You can add images 
to the question, by clicking on the image button on the left. When the game is launched, 
you can click on the image to enlarge it (to full screen). Click again to make it smaller.  

Load custom audio (MP3) (9 ): You can add audio files to the question, by clicking on 
the audio button on the left. You can only import MP3 files for audio.  

Topic Keywords (11) (optional): You can mark your question a keyword, that will help 
you search the database of questions, if you choose. For example, if your question is 
related to ladder safety, you may want to use Safety as your keyword for a search.  

Video Tips: When using video we suggest using a FLV (Flash Video Format) whenever 
you can. A FLV video features a playhead, so you can pause or rewind the video. A 
SWF Video will just play and will not provide you with a way to control of it. A SWF 
video will continue to loop until stopped.  

Online Audio Suggestion: If you want to narrate the text that appears on the screen, 
you can insert that as a audio file that will automatically start when the question is 
previewed.  

Online Use of Images, Video and Audio files: Just as in posting things for a website, 
the content in your game should be web friendly, from a size perspective. It is 
suggested, that if you are using images, that you try to keep the size no larger than 800 
x 600 and to use web settings when saving the images. The same principle should be 
applied to video and audio files.  

2.11.3 Billionaire Editor 

Billionaire Question Editor: 
 
NOTE: Copying & Pasting: To copy or paste in BRAVO!  use your shortcut 
commands. Ctrl + C to copy, and Ctrl + V to paste.  



 

Bonus Question: to make this question a bonus question, check the box upper right 
corner of Question Editor. 
 
(1) Font Attributes: When adding text to your question, you can modify the typeface 
(bold, italic, or underline).  To change the font style globally (whole game) go to 
Graphics  and choose a different Game Font. Remember, like PowerPoint, if you are 
making a game on one computer and plan on playing on another computer, make sure 
you use a font that will be on both computers. 
 
Using Hyperlinks: Select the text you want to hyperlink, click on the link icon (A), in the 
pop up menu type in your address you want opened in the game in the URL. Leave the 
target empty. You may want to underline the text to it to give a hyperlink look (B). To 
open a file on your local drive, replace the http:// with the local address like: 



C:\pics\mypic.jpg.   
 

  

(2) Preview: You can insert text, images, audio, or video here,to precede a question. 
This section will only appear when you've entered something here. This can be used as 
a teaching moment or as a set up for the question.  

(3) Summary: You can enter text, images, video, here that will follow a question. This 
section will only appear when you've entered test or any media in the summary 
area.?This can be used as a teaching moment or as a review of a question.  

(4) Difficulty: This is optional, but you can rate your questions with a difficulty level of 1, 
2 or 3. This will prove helpful, if you need to sort your questions by difficulty level. This 
feature will work with our new library system coming out in October of 2009.  

(5) Question Area: This is where you will type in your question.  

(5) Answers: Type, or copy and paste your answers here. A suggestion is to try and 
keep your answers short. Use the Summary to add additional information or teaching 
points.   
 
(6) Number of Answers: Billionaire game is based off a 4 answer multiple choice 
format. If you want other options for question styles use either Quiz Show or Spin Off.  



(7) Correct Answer: The green check mark in the radial button indicates the correct 
answer for the question..  

(8) Load custom images/video (SWF, JPG, GIF, PNG, FLV) : You can add images to 
the question, by clicking on the image button on the left. When the game is launched, 
you can click on the image to enlarge it (to full screen). Click again to make it smaller.  

(9) Load custom audio (MP3): You can add audio files to the question, by clicking on 
the audio button on the left. You can only import MP3 files for audio.  

 

(10) Question Points: You will note on the pyramid in the Billionaire player, that each 
level has a  title which by default is the numerical value assigned to each level. If you 
want to change the numerical value of each level change it here. To add a dollar sign, 
go to Settings and check Use dollar signs ($) on ladder.  See image above to see 
example.  

(10) Question Title: This is an optional setting. If you want to place text for each level 
this is where you would do this. Note the image below shows the text for the title for 
each level, The points that are assigned are whatever you have selected in the  
 
(11) Question Points: See image above to see example.  

(12) Topic Keywords (optional): You can give your question a keyword, that will help 
you search the database of questions if you choose. For example, if your question is 
related to ladder safety, you may want to use Safety as your keyword for a search. 
NOTE: A library will be added in October of 2009 and is not currently in the builder.  

Tips and Tricks  



Video Tips: When using video we suggest using a FLV (Flash Video Format) whenever 
you can. A FLV video when used will give you a playhead so you can pause or rewind 
the video. A SWF Video will just play and you will not have any control of it when using 
it. A SWF video will continue to loop until stopped.  

Online Audio Suggestion: If you want to narrate the text that appears on the screen 
you can insert that as a audio file that will automatically start when the question is 
previewed.  

Online Use of Images, Video and Audio files: Just like when posting things for a 
website, if you are using any content into your game you will want to make the files web 
friendly from a size perspective. It is suggested that if you are using images to try and 
keep the size no larger than 800 x 600 and to use web settings when saving the 
images. The same principal should be applied with video and audio files.  

2.11.4 Spin Off Editor 

Question Editor:  

Copying and Pasting: To copy or paste in BRAVO! use your shortcut commands: Ctrl 
+ C to copy, and Ctrl + V to paste.  



 

Bonus Question: to make this question a bonus question, check the box in the upper 
right hand corner of Question Editor. 

(1) Preview: You can insert text, images, audio, or video here, to precede a question. 
This section will only appear when you've entered something here. This can be used as 
a teaching moment or as a set up for the question.  

(2) Summary: You can enter text, images,or video here, that will follow a question. This 
section will only appear when you've entered text or any media in the summary area. 
This can be used as a teaching moment or as a review of a question.  

(3) Type: For open ended questions, you can choose from the Type drop down menu > 
Open-Ended or you can use the default answer style which is Multiple Choice.  If you 
are choosing open ended, you will see (on the game side) a simple correct (check 



mark) or incorrect (red X) option to answer the question. Place the correct answer in the 
empty answer area in the game builder and the answer will show up after a question is 
answered.  

 

(4) Difficulty: This is optional, but you can rate your questions with a difficulty level of 1, 
2 or 3. This will prove helpful, if you need to sort your questions by difficulty level. This 
feature works with our new library system.  

(5) Font Attributes: When adding text to your question, you can modify the typeface 
(bold, italic, or underline).  To change the font style globally (whole game) go to 
Graphics  and choose a different Game Font. Remember, like PowerPoint, if you are 
making a game on one computer and plan on playing on another computer, make sure 
you use a font that will be on both computers.  
 
Using Hyperlinks: Select the text you want to hyperlink, click on the link icon (A).  In 
the pop up menu, type in the URL address you want opened in the game.  Leave the 
target empty. You may want to  underline the text to it to give a hyperlink look (B). To 
open a file on your local drive, replace the http:// with the local address like: 
C:\pics\mypic.jpg.     



 

(6) Question Area: This is where you will type in your question.  

(7) Number of Answers: You can have up to 5 answers for your questions, if for 
example you have a True and False answer, then drop the number of answers to 2.  

(8) Answers:  Type, or copy and paste your answers here. Try to keep your answers 
short. Use the Summary to add additional information or teaching points.    

(9) Load custom images/video (SWF, JPG, GIF, PNG, FLV): You can add images to 
the question, by clicking on the image button on the left. When the game is launched, 
you can click on the image to enlarge it (to full screen). Click again to make it smaller.  

(10) Load custom audio (MP3): You can add audio files to the question, by clicking on 
the audio button on the left. You can only import MP3 files for audio.  

(11) Topic Keywords (optional): You can give your question a keyword, that will help 
you search the database of questions if you choose. For example, if your question is 
related to ladder safety, you may want to use Safety as your keyword for a search.  

Video Tips: When using video we suggest using an FLV (Flash Video Format) 
whenever you can. An FLV video will give you a playhead, so you can pause or rewind 
the video. An SWF Video will just play, and you will not have any control of it when 
using it. An SWF video will continue to loop until stopped.  



Online Audio Suggestion: If you want to narrate the text that appears on the screen, 
you can insert that as a audio file, that will automatically start when the question is 
previewed.  

Online Use of Images, Video and Audio files: Just as with posting things for a 
website, you want to make all files in your game as web friendly (from a size 
perspective) as possible. It is suggested that you keep the size of all images no larger 
than 800 x 600, and that you use web settings when saving the images. The same 
principle should be applied to video and audio files.  

2.11.5 Preview & Summary Screens 

Preview & Summary Screens  

 
The Preview screen appears before a question, and the Summary screen appears 
after the question. Both screens work exactly the same way:  when they contain any 
content, they will automatically appear in the game. You can enter, text, images, and 
video here. The Preview and Summary screens will only appear when you've entered 
content. The summary is used as a way to add additional information after a question. 
We suggestion that you try to keep your answers short, and use the summary area to 
expand on your answer. In the examples below, you will note how images, text, and 
audio will appear in the game builder and then in the game player. When using an 
image (SWF, JPG, GIF, PNG, FLV), you can click on the image to go to full screen for 
better viewing. To clear any data in the editor, click the Clear button.  

Using Images in Questions: If you are going to use an image as part of a 
question, consider placing it in the preview slide. 

Using the Preview Slide to Set up a Question: Consider using the preview 
slide to set up a question.  Let's say, for example, that your question is this: You have a 
56 year old male having chest pain and shortness of breath, for the past 2 hours. What 
should be your first treatment? In the preview slide type in: You have a 56 year old male 
having chest pain and shortness of breath, for the past 2 hours., In the question 
area, type in: What should be your first treatment? This helps keep your questions 
simple and easy to read. 



 

Use of Text in the Preview or Summary Screens.  

 



 

Use of Images and Audio Files in the Summary or Preview Screens 
The optimal size for images in the preview and summary slides is 600x494.  



 

This is how an image with audio will appear in the Summary or Preview area game 
player. 


















































































































































